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What is MetaClear? 
MetaClear is a native macOS privacy tool that strips hidden metadata from your photos 

before you share them. Every image file you take or save contains invisible embedded 

data -- your GPS location, the camera or phone you used, the date and time, and in AI-

generated images, the exact prompt and model used to create them. MetaClear removes 

all of it in seconds, leaving your photo intact and your private information private. 

MetaClear works entirely on your Mac. No account is required, no data is uploaded 

anywhere, and your files never leave your device. It is a one-time purchase with no 

subscription. 

Who is MetaClear for? 
• Parents who share photos of their children and want to protect their family's location 

from being embedded in every image. 

• Photographers who share work publicly and want full control over what technical 

information travels with their images. 

• Anyone who uses AI image tools and wants to remove embedded generation 

parameters before sharing. 

• Privacy-conscious individuals who simply want to know -- and control -- what data 

their photos carry. 

How MetaClear Works 
MetaClear uses two separate pipelines that run in sequence on every file. 

Standard Metadata Pipeline 
The first pipeline uses Apple's ImageIO framework to read the image, strip selected 

metadata fields, and write a clean copy alongside the original. This handles GPS 

coordinates, device information, timestamps, software identifiers, and ownership data. It 

works for all supported formats: JPEG, PNG, TIFF, HEIC, HEIF, WebP, AVIF, and RAW 

files. 
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AI Content Stripping Pipeline 
The second pipeline operates at the raw byte level on the file produced by the first 

pipeline. It removes AI provenance data that the standard ImageIO pipeline cannot reach 

-- C2PA Content Credentials embedded in JPEG APP11 segments and PNG chunk 

structures, Stable Diffusion and ComfyUI generation parameters, XMP generative edit 

history, and IPTC digital source type indicators. 

Your Original Is Never Touched 
MetaClear always writes a new clean copy of your file. Your original is never modified, 

overwritten, or deleted. The clean copy is saved alongside the original with a 

configurable suffix (default: _clean). You can change the output location or suffix in 

Settings. 

System Requirements 

Getting Started 
On first launch MetaClear presents a brief welcome screen that walks you through the 

three steps of its workflow: drop your photos, review what was found, and clear the 

metadata. After completing the welcome screen you will not see it again unless you 

reopen it from the Help menu. 

License Activation 
MetaClear includes a five-use trial so you can verify it works with your files before 

activating. A trial use counter appears at the top of the window while in trial mode. To 

Requirement Minimum

macOS macOS 26 or later

Architecture Apple Silicon (M1 or later)

Storage 10 MB for the application

Memory 4 GB RAM recommended for large batches

Internet Not required for use
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activate, open Settings, scroll to the License card, enter your name, email address, and 

license key, then click Activate License. 

First Run Checklist 
• Open MetaClear from your Applications folder. 

• Complete the welcome screen. 

• Drag a photo onto the drop zone or click Browse for Photos. 

• Review the metadata tags shown on the file card. 

• Click Clear All Metadata. 

• Use the folder icon on the file card to locate the clean copy. 

The Clear Photos Screen 
The Clear Photos screen is the main workspace. It is divided into three zones: the sidebar 

on the left, the drop zone at the top of the content area, and the file queue below it.  

Sidebar 
The sidebar shows the app name, navigation links, a session counter showing how many 

files have been processed in the current session, lifetime statistics, and links to 

korerium.com and support. 

Drop Zone 
The drop zone is the large dashed rectangle at the top of the content area. Drag photos 

or folders here to add them to the queue. You can also click the blue 'click to browse' 

link to open a file picker. The drop zone accepts JPEG, PNG, HEIC, HEIF, TIFF, WebP, 

AVIF, RAW formats, and folders. 

File Queue 
Files you add appear as cards in the queue below the drop zone. Each card shows a 

thumbnail, the filename, metadata category tags, and a status badge. You can click any 

card to open the Metadata Preview Panel for a detailed breakdown of what is in that file. 
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Bottom Bar 
The button at the bottom of the screen changes based on the state of the queue. When 

empty it reads Browse for Photos and opens the file picker. When files are loaded it 

reads Clear All Metadata and processes the entire queue. 

Dropping Files and Folders 
MetaClear accepts individual files and entire folders. You can mix both in a single drop.  

Individual Files 
Drag one or more image files directly onto the drop zone. MetaClear accepts files from 

Finder, the Desktop, external drives, and network volumes. Files are added to the queue 

immediately and their metadata is read in the background while you continue working. 

Folders 
Drag any folder onto the drop zone. MetaClear recursively scans the folder and all 

subfolders, collecting every supported image file it finds. This works to any depth -- a 

folder containing subfolders containing more subfolders will be fully scanned. When 

processing a folder, clean copies are saved next to each original inside the existing folder 

structure. For example, a file at Vacation/Beach/photo.jpg produces a clean copy at 

Vacation/Beach/photo_clean.jpg. Your folder organization is preserved exactly.  

Important: MetaClear does not process files from the Photos app library. To process a 

photo from Photos, export it using File > Export, then drop the exported file onto 

MetaClear. This is a deliberate design decision -- working with real filesystem files 

ensures you always know exactly where your clean copies are saved. 

Large Batches 
When more than 50 files are added at once, MetaClear shows a notice confirming that all 

files will be processed in the background and your Mac will stay responsive. Processing is 

throttled to four concurrent files at a time to maintain system performance. 

Understanding File Cards 
Each file in the queue is represented by a card showing its thumbnail, filename, metadata 

tags, and status. 
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Metadata Tags 
Before processing, tags show which metadata categories are present in the file. After 

processing, the same tags show in ocean blue indicating which categories were 

successfully cleared. An AI tag appears if AI provenance data was detected and stripped. 

Status Badges 

Action Icons 
• After processing completes, one or two icons appear to the right of the status badge. 

• Folder icon -- opens Finder to the location of the clean file. 

• Document icon -- opens Finder to the JSON metadata report (only visible when reports 
are enabled in Settings). 

• Right-clicking a card opens a context menu with the same options plus a Remove from 
queue action. 

Warning Banners 
• Two types of warning banners may appear at the top of a file card: 

• Already cleaned warning (amber) -- the filename ends with _clean, suggesting it may 

have been processed before. 

• RAW conversion notice (blue) -- the file is a RAW format and will be converted to TIFF 

on output. 

Badge Meaning

Queued File is waiting to be processed

Processing MetaClear is actively stripping metadata from this file.

X fields removed
Processing complete. The number shows how many 

individual metadata fields were removed.

No metadata found
The file contained no removable metadata. A clean copy 

was still created.

Failed
Processing encountered an error. Hover over the badge 

to see the error message.
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What Gets Removed 
MetaClear organizes removable metadata into five standard categories plus a separate AI 

and Content Credentials category. 

Location 
GPS and location data embedded by cameras and smartphones. 

 
Device 
Hardware identifiers that reveal the camera or phone used. 

 
Time and Capture 
Timestamps and capture settings. 

Field Description

GPS Latitude / Longitude Precise coordinates where the photo was taken.

GPS Altitude Elevation above sea level at capture time.

GPS Timestamp UTC time recorded by the GPS receiver.

GPS Speed / Direction Movement data recorded during capture.

Field Description

Make / Model Camera manufacturer and model name.

Serial Number Unique hardware identifier for the camera body.

Lens Model Lens make and model.

Firmware Version Software version running on the camera.

Field Description

DateTimeOriginal Date and time the shutter was pressed.

DateTimeDigitized Date and time the image was digitized.

Shutter Speed Exposure time in seconds.

Aperture F-stop value at capture.
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Software and Profile 
Software identifiers and color profile data. 

Ownership 
Copyright and attribution data. This category is off by default as some photographers 

intentionally embed this information. 

AI and Content Credentials 
Data embedded by AI image generation tools. This category is off by default and can be 

enabled in Settings. 

ISO Sensor sensitivity setting.

Focal Length Focal length of the lens in mm.

Exposure Program Auto, manual, aperture priority, etc.

Field Description

Field Description

Software Application used to create or edit the image.

CreatorTool XMP field identifying the creating application.

Processing Software RAW processing application name.

Color Profile Embedded ICC color profile.

Field Description

Copyright Copyright notice embedded in the file.

Artist Photographer or creator name.

Credit Credit line for agency or wire service photos.

Rights Rights management information.
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Processing Your Photos 
Once files are in the queue, click Clear All Metadata to begin processing. MetaClear 

processes up to four files concurrently. 

Processing Order 
Files are processed in the order they appear in the queue. Each file goes through the 

standard metadata pipeline first, then the AI stripping pipeline if AI removal is enabled in 

Settings. 

RAW Files 
MetaClear supports CR2, CR3, NEF, ARW, and DNG RAW formats. Because proprietary 

RAW formats cannot be re-encoded without specialized codec support, clean copies of 

RAW files are output as TIFF. The original RAW file is never modified. A blue banner on 

the file card indicates when this conversion will occur. 

Output Location 
By default, clean copies are saved in the same folder as the original file, with _clean 

appended to the filename before the extension. A photo named photo.jpg produces 

photo_clean.jpg in the same folder. 

You can change the output folder and suffix in Settings. If a custom output folder is set, 

all clean copies go there regardless of where the originals are located. 

For folder drops, the default behavior preserves the original folder structure. Clean 

copies are placed next to each original inside the existing folder hierarchy. 

Field Description

C2PA Credentials Adobe Firefly, DALL-E, and OpenAI provenance tokens.

SD Parameters

Stable Diffusion and ComfyUI generation parameters 

including prompt, negative prompt, seed, model name, 

and steps.

XMP AI History Adobe Generative Fill edit history and AI action records.

IPTC Source Type digitalSourceType field identifying AI-generated content.
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Auto-Process on Drop 
Enable Auto-process on drop in Settings to have MetaClear begin processing 

immediately when files are added to the queue, without requiring a click of the Clear All 

Metadata button. This setting is off by default. 

Metadata Preview Panel 
Click any file card to open the Metadata Preview Panel for that file. The panel shows a 

complete breakdown of every metadata field found in the original image. 

GPS Map 
If the file contains GPS coordinates, the top of the panel shows a map tile centered on 

the location where the photo was taken. This makes it immediately clear how precise the 

location data is. 

Field List 
All metadata fields are listed by category. Fields that will be removed are shown in the 

primary text color. Fields that will be kept are shown in secondary text. The field key, 

human-readable name, and current value are shown for each entry. 

AI Provenance Section 
If AI provenance data is detected, a dedicated section appears listing the specific signals 

found — for example the presence of C2PA tokens, Stable Diffusion parameters, or XMP 

generation history. This section appears even if the AI removal toggle is off, so you can 

see what is present before deciding whether to enable it. 

Session Complete 
When all files in the queue have been processed, a Session Complete sheet appears 

summarizing the session results. 
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Summary Sheet 
The sheet shows the total number of files cleared, the total number of metadata fields 

removed, a breakdown of fields removed by category, and the total processing time. If AI 

content was stripped, the number of files affected is also shown. 

Done and View Session History 
Click Done to dismiss the sheet and return to the queue. Click View Session History to 

navigate to the Session History screen which shows a per-file breakdown of the session 

results. 

New Session 
To clear the queue and start fresh, click the New session link in the queue header, or click 

New session in the Session Complete sheet. This clears all files from the current queue 

but does not affect the clean copies already saved to disk. 

Settings 
Open Settings from the sidebar to customize how MetaClear handles your files. 

Output 
Click the output location row to choose a custom folder for all clean copies. By default 

MetaClear saves clean copies alongside each original. Click Reset to default location to 

revert to the default behavior. 

File Naming 
The clean file suffix is appended to the filename before the extension. The default is 

_clean, producing filenames like photo_clean.jpg. You can change this to any string -- for 

example _web, _share, or _safe. 

Processing Defaults 
These toggles control which metadata categories are removed when you process a file. 

The defaults are: 
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Metadata Reports 
MetaClear can generate a JSON sidecar report alongside each clean file. Reports are off 

by default, but can be enabled in Settings under Metadata Reports. 

What the Report Contains 
• The original filename and the clean copy filename. 

• The date and time of processing. 

• The MetaClear version used. 

• Total fields found, removed, and kept. 

• A breakdown of removed fields grouped by category. 

• A breakdown of kept fields grouped by category. 

• Whether AI content was stripped. 

• Whether a RAW file was converted to TIFF. 

• A note if the file contained no metadata. 

Report Filename 
Reports are named using the clean file's base name with _report.json appended. A clean 

file named photo_clean.jpg produces a report named photo_clean_report.json saved in 

the same folder. 

Category Default Description

Location ON
High privacy risk -- reveals when and 

where.

Device ON
High privacy risk -- identifies your 

hardware.

Time and Capture ON High privacy risk -- reveals when and how.

Software and Profile OFF Lower risk -- often benign.

Ownership OFF Some photographers want this preserved.

AI Content Credentials OFF Enable if sharing AI-generated images.

Auto-process on drop OFF Power user feature -- opt in deliberately.
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Accessing Reports 
When a report has been generated, a document icon appears on the file card next to the 

folder icon. Clicking it opens Finder to the report file. Reports can also be accessed via 

the file card context menu. 

Session History 
The Session History screen shows every file processed during the current session. It 

resets when you quit MetaClear. 

The top of the screen shows a summary card with the total files cleared and fields 

removed, followed by a per-file list showing the filename, number of fields removed, and 

a success or failure indicator. 

Session history is intentionally session-scoped. MetaClear does not maintain a permanent 

processing log across sessions. If you need a permanent audit trail, enable Metadata 

Reports in Settings -- the JSON files on disk serve as the permanent record. 

Lifetime Stats 
The sidebar shows all-time totals for files cleared and fields removed across all sessions. 

These accumulate across app launches and are stored in your Mac's preferences. You can 

reset them at any time in Settings under Lifetime Stats. 

License Activation 
MetaClear includes a five-use trial. After five uses you will need to activate a license to 

continue processing files. 

How to Activate 
• Open Settings from the sidebar. 

• Scroll to the License card. 

• Enter your first and last name. 

• Enter the email address you used to purchase MetaClear. 

• Enter your license key exactly as it was delivered -- including the dashes. 

• Click Activate License. 
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Activation is verified entirely offline using a cryptographic key derived from your email 

address. No internet connection is required. 

License Key Format 
License keys are 35 characters in the format: 

XXXXXXXX-XXXXXXXX-XXXXXXXX-XXXXXXXX 

Support 
If you have trouble activating, contact support@korerium.com with your order 

confirmation and the email address used to purchase. 

A Note on Photos App 
MetaClear does not support direct drag-and-drop from the macOS Photos app library. 

This is a deliberate design decision, not a limitation we plan to work around. 

The Photos library is a managed, sandboxed database. When macOS delivers a Photos 

drag to a third-party app, it exports the asset to a temporary system location with a 

system-generated filename rather than the original file path. This means there is no 

stable, user-visible location for the file, and no predictable place to deliver the clean  

copy. 

The correct workflow for processing photos from your Photos library is: 

• Select the photo in Photos. 

• Choose File > Export > Export Unmodified Original. 

• Save the exported file to your Desktop or a known folder. 

• Drop the exported file onto MetaClear. 

• The clean copy will be saved alongside the exported original. 

This two-step process gives you a permanent file with a known location, a clean copy 

you can find and share, and a metadata report you can keep alongside both. It is a safer 

and more explicit workflow than an in-place Photos library edit. 
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Privacy Statement 
MetaClear is a local-first application. It does not collect, transmit, or store any data about 

you, your files, or your usage. 

What MetaClear Does Not Do 
• Does not connect to the internet for processing or license validation. Internet is only 

required to view maps in the Metadata Preview Panel. 

• Does not send usage analytics or telemetry. 

• Does not upload your photos or metadata to any server. 

• Does not require an account, email address, or login. 

• Does not store any information about which files you have processed. 

• Does not track which metadata fields are present in your photos. 

What MetaClear Stores Locally 
MetaClear stores your preferences -- output folder, clean suffix, processing defaults, and 

lifetime statistics -- in your Mac's standard preferences system (NSUserDefaults). This 

data never leaves your Mac. You can reset it at any time by choosing Settings > Lifetime 

Stats > Reset, or by running the following command in Terminal:  

defaults delete com.korerium.MetaClear 

License Verification 
License key validation is performed entirely offline using HMAC-SHA256 cryptography. 

Your email address and license key are never transmitted to Korerium or any third party. 

Validation happens on your Mac using a locally computed cryptographic signature. 

Contact 
Questions about MetaClear's privacy practices can be directed to 

support@korerium.com
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